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Documentation Updates 

The title page of this document contains the following identifying information: 

• Software Version number, which indicates the software version. 
— The number before the period identifies the major release number. 
— The first number after the period identifies the minor release number. 
— The second number after the period represents the minor-minor release number. 

• Document Release Date, which changes each time the document is updated. 

• Software Release Date, which indicates the release date of this version of the software. 

To check for recent updates or to verify that you are using the most recent edition, visit the 
following URL: 

http://h20230.www2.hp.com/selfsolve/manuals

This site requires that you register for an HP Passport and sign-in. To register for an HP 
Passport ID, go to:  

http://h20229.www2.hp.com/passport-registration.html

Or click the New users - please register link on the HP Passport login page. 

You will also receive updated or new editions if you subscribe to the appropriate product 
support service. Contact your HP sales representative for details. 

Table 1 lists document changes for current release. 

Table 1 Documentation Changes 

Chapter Version Changes 

Title 
Page 

7.90 Updated product version number and release date for 7.90. 

Chapter 
3 

7.90 Packaging Applications, the Profile Samples directory path is 
modified to Media\Application Management 
Profiles\Profile Samples. 

Title 
Page 

7.80 Updated product version number and release date for 7.80. 

All 7.20 Configuration Management was renamed to HP Client 
Automation (HPCA) for the 7.20 release. Note that not all 
components and products were re-branded. 
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Chapter Version Changes 

All 7.20 The Application Manager agent as of Version 7.20 includes 
embedded support for running Application Management Profiles. 
All references to the previous the Server Management agent have 
been replaced with references to the Application Manager agent. 

2, 3 7.20 To package and promote the installation media for use with 
AMPs, replaced references to using the Administrator Packager 
feature with references to using the Administrator Publisher 
feature; the HPCA Admin Publisher now includes the Component 
Selection Mode that is typically used to package and promote 
media for use with AMPs. 

3 7.20 This release of Application Management Profiles (AMPs) supports 
HPCA managed devices running Windows and Linux. It no longer 
supports devices or features for AIX, HP-UX and Solaris 
managed-devices.  

3 7.20 
Aug 2008 

Page 29, Header Information, refreshed sample image. 

3 7.20 
Aug 2008 

Page 35, Search Filters, modified topic title and text. Replaced 
note referencing samples on the media with the following: 

Note: Starting with version 7.20, the HP Live Network can be 
used to access AMP samples, including examples of how to use 
the search filters. 

Appendix 7.20 
Aug 2008 

Removed previous Appendix A: Product Name Changes, which 
applied to changes from Version 4.x to 5.x. 
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Support 

You can visit the HP Software support web site at: 

www.hp.com/go/hpsoftwaresupport

This web site provides contact information and details about the products, services, and 
support that HP Software offers.  

HP Software online software support provides customer self-solve capabilities. It provides a 
fast and efficient way to access interactive technical support tools needed to manage your 
business. As a valued support customer, you can benefit by using the support site to: 
Search for knowledge documents of interest 
Submit and track support cases and enhancement requests 
Download software patches 
Manage support contracts 
Look up HP support contacts 
Review information about available services 
Enter into discussions with other software customers 
Research and register for software training 

Most of the support areas require that you register as an HP Passport user and sign in. 
Many also require an active support contract. To find more information about support access 
levels, go to the following URL:  

http://h20230.www2.hp.com/new_access_levels.jsp

To register for an HP Passport ID, go to the following URL: 

http://h20229.www2.hp.com/passport-registration.html
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1 Introduction 
At the end of this chapter, you will: 

• Be familiar with capabilities of HP Client Automation Application 
Management Profiles (AMPs). 

• Know its terminology. 
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Application Management Profiles 
The Application Management Profiles (AMPs) includes a set of tools built on 
top of the HP Client Automation Application Manager (Application Manager) 
to enable the deployment and management of complex software products that 
are typically required on the managed clients and servers in a Client 
Automation environment, such as Symantec Antivirus, Microsoft Office 2007, 
Microsoft SQL Server, Oracle, Apache, and Internet Information Server, 
among others. These products often employ their own instrumentation or 
repositories for deployment and management of their implementation. 

Application Management Profiles provides tools to: 

• Analyze and parameterize configuration control data for targeted 
products. 

• Specify values in the form of a model to be used at deployment time. 

• Articulate in the model pre-requisites and constraints that qualify the 
ability to deploy the products. 

• Publish the control information and required ancillary tools such as 
utility programs to the Client Automation infrastructure for deployment. 

• Deploy and configure the software to targeted devices. 

• Interact with the target environment before and after installation to 
enhance management of the deployment. 

• Report on the success of the deployment. 

The intent of this book is to provide instruction on how to deploy applications 
using these tools. The figure below provides a general workflow. 

 
As of CM Version 5.10, you can now use AMPs to control complex 
application installs on both managed clients and servers in your 
Client Automation environment, and you do not need to own a 
Server LTU for the Application Manager. 
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Figure 1 Workflow 

 

Terminology 

The following terms are used in this guide and are specific to AMPs: 

Application Manager Agent 

The software that must be installed on the target device to execute an 
Application Management Profile. 

Application Management Profile Editor (AMP Editor) 

A tool to create and modify application profiles. 
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Master Application Profile (MAP) 

An XML-based specification of an application’s installation parameters. A 
parameter in the XML might refer to the installation directory of an 
application. 

Custom Application Profile (CAP) 

A MAP that has been customized to your environment. 

Utility Class 

A class in the HP Client Automation Configuration Server Database (CSDB) 
specifically used for a particular application. For example, the Utility Class 
used for Microsoft SQL Server 2000 is called MSSQL2K. 

Using this Guide with Core and Satellite Servers 

 
If your environment uses Core and Satellite servers, first read the 
Core and Satellite Servers Getting Started Guide as the installation, 
configuration, and troubleshooting information in that guide may 
override the information in this guide. 

Audience 
This guide is for administrators of AMPs. You will learn how to use the tools 
supplied to deploy server or client applications. 

Prerequisites 
The reader should be familiar with the following products: 

HP Client Automation Configuration Server (Configuration Server) 

HP Client Automation Administrator (Administrator) 

HP Client Automation Application Manager (Application Manager) 
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HP Client Automation Portal (Portal) 

 
To use AMPs to deploy applications, the target devices must be 
installed with the Application Manager agent from Version 7.20 or 
above. There is no additional LTU required. 

Additional Components 

In addition to already established Client Automation products, AMPs use: 

• Master application profiles for supported applications 

• A set of methods specific to deploying applications on the target device. 
These are embedded in the Application Manager agent. 

• The Application Management Profiles Editor (AMP Editor) to administer 
the profiles 

Chapters Summary 
In addition to this chapter, this book contains the following information 

• Installing AMPs 

• Packaging applications 

• Preparing applications 

Related Documents 
HP Client Automation Administrator User Guide 

HP Client Automation Configuration Server User Guide 

HP Client Automation Reporting Server Installation and Configuration Guide 

HP Client Automation Portal Installation and Configuration Guide 
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2 Installing Application Management 
Profiles 

At the end of this chapter you will: 

• Know how to install the components needed to use HP Client Automation 
Application Management Profiles (AMPs). 

 
If your environment uses Core and Satellite servers, first read the 
Core and Satellite Servers Getting Started Guide as the installation, 
configuration, and troubleshooting information in that guide may 
override the information in this guide. 
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Installation Media 
AMPs requires the following: 

• The Application Management Profiles Editor (AMP Editor) is installed as 
part of the HP Client Automation Administrator (Administrator). 

• AMPs contain one subdirectory for each provided profile. Each 
subdirectory includes the profile, a descriptive html document, and a 
Profile Note. 

• The APPMGMT Domain for the HP Client Automation Configuration 
Server DB (CSDB) installed by default in the Configuration Server 
Version 5.00 or above. 

• The target device requires the Application Manager agent. See 
Application Manager Agent. 

 
Note that on 64-bit Windows architectures the agent and 
profiles will run in 32-bit emulation mode. HP recommends 
using fully qualified paths in your profiles to make sure that 
you are able to run 64-bit executables on 64-bit operating 
systems. The agent and profiles may be affected by registry and 
file redirection as documented in the Microsoft knowledge base 
articles, Overview of the compatibility considerations for 32-bit 
programs on 64-bit versions of Windows Server 2003 and 
Windows XP. As always, be sure to thoroughly test your profiles 
before deployment. 

Prerequisites 

Before installing the components on the Application Management Profiles 
media, you will need to complete the following tasks: 

• Designate a HP Client Automation Configuration Server (Configuration 
Server) to host your profiles and policy information. 

• On a computer designated for administration, install the HP Client 
Automation Administrator (Administrator) and select the HPCA Admin 
CSDB Editor and HPCA Admin Publisher  features. 

• Install HP Client Automation Application Manager (Application 
Manager) on your target devices. 

• Install HP Client Automation Messaging Server (Messaging Server). 
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• Install HP Client Automation Reporting Server (Reporting Server). 

 
All components of the Client Automation infrastructure must 
come from the media for release 5.00, at a minimum, unless 
otherwise noted. 

Platform Support 

For information about the platforms that are supported in this release, see 
the accompanying release notes. 

Installation Process 
After meeting the prerequisites, you will need to do the following: 

• Install Configuration Server version 5.00 or above. Version 5.00 is the 
minimum required version.  

• Install the HP Client Automation Administrator AMP Editor. 

System Requirements for the AMP Editor 

The AMP Editor is part of the Administrator. 

• TCP/IP connection to the Configuration Server. 

• Minimum resolution of 800 x 600. 

• For Windows 2000, Server 2003, or XP or Vista, you must have 
administrator rights to the computer to install the Administrator. 

Platform Support 

For information about the platforms that are supported in this release, see 
the accompanying release notes. 
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Installing the AMP Editor 

The AMP Editor allows you to modify the profiles provided. The AMP Editor 
is a part of the Administrator. For convenience, install the AMP Editor on the 
same computer as the CSDB Editor and Publisher. From the administrator 
installation media, click setup.exe. Select the AMP Editor feature when 
prompted. 

 
The administrator installation media is located on the Client 
Automation media in the \Configuration Server\management 

_infrastructure\administrator_workstation\win32\ folder. 

 

Figure 2 Administrator features 

 

To start the AMP Editor 

• From the Start Menu, go to HP Client Automation Administrator  Client 
Automation AMP Editor. 
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3 Packaging Applications 
At the end of this chapter you will: 

• Know how to package the installation media. 

• Be able use the HP Client Automation Administrator AMP Editor (AMP 
Editor) to create your Custom Application Profiles (CAP). 

• Be familiar with how to publish the CAP to the HP Client Automation 
Configuration Server DB (CSDB). 

19 



 

Packaging Applications 
To package the application, you must perform the following tasks: 

1 Package the installation media. 

2 Modify the profile to create your Custom Application Profiles (CAP). 

3 Package the CAP. 

Figure 3 Package the application 
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Packaging the Installation Media 
You can use the HP Client Automation Administrator Publisher (Publisher) 
to create an installation point or access the media from a network share. The 
Component Select mode of the Publisher might be the simplest approach to 
use. 

To package the installation media using Component Select Mode 

Use Component Select Mode to promote the application’s installation media. 
For complete information on the Publisher, see the HP Client Automation 
Administrator User Guide (Admin Guide). 

 
Be sure that your Configuration Server has adequate space for the 
installation media. 

• Copy the installation media to a directory path where the software will be 
installed from on the client computer. If you do not package from this 
directory, you will need to change the Path instance in the CSDB. 

• Give the package a meaningful name. 

• Promote the package to the APPMGMT Domain, not the SOFTWARE 
Domain. 

Figure 4 Promote the installation media to APPMGMT Domain 
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AMP Editor 
This tool allows you to make an AMP available to the system for deployment. 
This interface allows you to: 

• Construct or modify a profile for use with a specific software package. 

• Open a profile for customization from local file system. 

• Create configuration settings. 

• Add commands to be run before, during, and after an installation. 

• Publish the AMP to the CSDB. 

Master Application Profiles (MAP) will be provided for each supported 
application. These will serve as examples that you can use to create your own 
company-specific deployments called CAP. 

 
At the time of this writing, the AMP Editor is available only on 
Windows operating systems. 

Creating a Custom Application Profile 
Use the AMP Editor to create your own CAPs from the examples provided by 
HP. The AMP Editor should be installed on an administrator computer with 
access to these files. The AMP Editor is organized into tabs. Tabs may vary 
from one application to another. All of the files have a Header Info, 
Configuration and File Templates tab. When creating a profile, a backup file 
is saved to the operating system’s temp directory with a .bak extension. 

Tabs and Phases 

From the File menu of the AMP Editor, open a profile. 

For convenient retrieval, the File menu displays up to ten of the most 
recently used (MRU) profiles at the bottom.  
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Figure 5 Tabs of Configuration Server sample file 

 

Each profile may or may not have the following tabs included: 

• Header Info 
Use this tab to specify the version of the profile, and assumptions, and 
list the profile’s features. 

• Configuration 
Use the configuration tab to edit installation parameters. These values 
can be referred to in commands that you create. 

• File Templates 
Shows the files that the profile will modify on the target computer. 

• Initialize 
During the Initialize phase, the Application Manager agent gets 
information that will be used during the Install Phase. 

• Search Filters 
Use this tab to create search elements to be used on data, such as a result 
of a registry query example, or a text file. 

• Pre-Install 
Specify any commands that you want to run before the installation such 
as turning off anti-virus software or checking for disk space. 

• Install 
Specify the commands to run the installation such as executing the setup 
file or checking if a computer restart is needed. 

Packaging Applications 23 



 

• Verify 
Specify the commands to run to verify the application is installed 
correctly. 

• Repair 
Specify the commands to run if the application needs to be repaired 

• Update 
Specify the commands to run to update the application. 

• Delete or Uninstall 
Specify any commands that you want to run when the application is 
removed from the target computer. 

Tab Navigation 

Click a tab to select that phase in the profile. Alternatively, use Ctrl+Tab to 
select the next tab and Ctrl+Shift+Tab to select the previous tab. 

Managing Phases 

The AMP Editor allows you to add and manage the phases in a profile. When 
a Phase is added or modified, all fields are checked for completion. 

To add a phase 

1 From the Edit menu, click Manage Phases. 
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2 Click Add Phase. 
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3 Type a Phase name, Display Title, and Description.  

4 If the Phase execution is to be dependent upon a pre-condition, select 
Check pre-condition in the Pre-condition expression area. Additional 
fields for defining a Phase pre-condition expression will be displayed. 
Refer to  on page  for more information.Phase Pre-Conditions 28  

5 If needed, select a mode for the phase. See Command Modes on page 48 
for more information. 

6 Select the On error, continue phase check box if you want to be able to 
do all the commands in a phase even if they failed. 
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For new profiles, the Verify phase defaults to On error, 
continue phase. For all other phases, you must manually set 
this. In older profiles, you will need to set this as well. 

7 This will ensure that you catch all the anomalies in one attempt as 
opposed to one per attempt 

8 Click Done to confirm the settings. 

9 Click Done when you are finished managing phases. 

To manage phases 

1 From the Edit menu, click Manage Phases. 

 

2 Click on the phase to be managed. 

3 Click on the action you want to perform. 

— Click Delete to remove a phase. 

— Click Move Up to move a phase up. 
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— Click Move Down to move a phase down. 

— Click Modify to change the Phase Name, Display Title, Description, 
or Modes for this phase. 

— Click Add Phase to add a phase below the currently selected phase. 

4 When you have completed your changes, click Done. 

Phase Pre-Conditions 

When adding or modifying a phase, you can specify a pre-condition. Phase 
pre-condition checks allow the phase to be executed only if the pre-condition 
is met. In the Pre-condition expression area of the Add or Modify Phase 
dialog, click Check pre-condition, use the string builder to specify the pre-
condition, and then type an Error message. 

 

If the phase pre-condition is not met, the phase is skipped. Be sure to provide 
a descriptive error message to show why a phase may be skipped. This Error 
message is displayed in the client computer’s connect.log and in the 
Reporting Server. 

Using a Pre-Condition 

If the phase pre-condition is false or not met, the phase will not run, and 
execution continues with the next phase. In other words, the phase will run 
only if the pre-condition is true or met. In the example below, our profile will 
optionally install Java. Our profile defines a Boolean parameter for:  

• Install Java? (where checked is True, and unchecked is False) 

When creating the phase named JAVAINSTALL, we also defined a Phase 
pre-condition that references the value of the Install Java? parameter.  

If this parameter value is true (that is, if the prompt for Install Java? was 
checked), the Java Install Phase will execute. If this parameter’s value is 
false (that is, Install Java? was not checked), the Java Install phase will not 
execute. Pre-condition expressions are defined using the String builder. For 
more information, refer to Building a String on page 46. 
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When the Java Install Phase pre-condition is not met, the computer’s 
connect.log will include the error message: SKIPPED: Java Install 
Not Selected!! 

Figure 6 below shows the Add Phase dialog entries used to set the Java 
Install Phase pre-condition. 

Figure 6 Use a Phase pre-condition 

 

Header Information 

Use header information to track versions, authors, and features of 
application management profiles. In addition, you select platforms for the 
profile. This will filter the commands appropriately for your platform. 

In the document header, you can type a language for the profile. 

To create header information 

1 From the Header Info tab, click Header Info. 

2 In the Editor, type in the values you want. 
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3 From the Platform drop-down list: 

— Select Windows to view only the commands usable in Windows when 
you view the Add Command dialog box. 

— Select Unix to view only the commands usable in Unix when you 
view the Add Command dialog box. 

— Select Any to view all commands no matter what platform you are 
using. 

The header information has been added to the application profile’s xml file. 
You may also do this to add a list of Features and set Assumptions for the 
profile. 

Configuration Settings 

Create sections of Configuration Settings to construct your AMPs. For each 
section, create instances with the necessary parameters. HP provides a set of 
sample profiles that you may use to see examples of configuration settings. 
We recommend the following sections: 
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• Installation Configuration: Use this for parameters needed during 
installation such as installation drive and directory. 

• Product Configuration: Use this for parameters required for product 
configuration options that can be changed after installation such as 
parameters required for running a service. 

• Security Configuration: Use this to define domain accounts and 
passwords required for installing or running the application. 

• Command Definition: Use for any custom commands you will use in 
multiple phases. 

• Requirement Definition: Use this to specify minimum requirements 
such as free disk space and operating system.  

• Temporary Storage: Use this section for items that are populated from 
local machine information for use in the application management profile. 
Examples would be the operating system’s temporary directory, current 
operating system, and environmental variables. 

• User Credentials: Use this section to create specific user credentials for 
application installation. Not all applications require this. This section is 
invisible by default. 

By design, you will not automatically see a User Credentials 
section in Configuration Settings. To create one, click [ + ] under 
the Configuration sections box, and then click New Instance, not 
New Section. Complete the Add New Configuration Instance 
dialog: select the User credentials section and give it an instance 
name. Click Done. 

To add a section to Configuration Settings 

1 From the Configuration tab, click [+] underneath the sections box. 

 

2 Click New section. 
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3 Type a Section name, Display title, Description, and Minimum and 
Maximum number of occurrences. In this example, we are creating a 
section for Product Configuration parameters. 

4 Click Save. 

The new section is created. You will need to add parameters to the section. 

To add a parameter to a section 

1 From the Section, click Manage parameter. 

2 Click Add to add a parameter. If you want to change an existing 
parameter, click Modify. To remove a parameter, click Delete. 

3 Type in a Parameter name, Display title, Description, Default value (if 
needed), Length and Parameter Type. Check the Read only check box if 
you do not want this parameter edited. Check the Store encrypted 
check box to encrypt the parameter. Click Store in utility class to add 
this parameter to the profile’s Utility Class. 
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The default encryption for parameters is AES. This requires 
nvdkit minimum build 443 on the Application Manager agent. 

 When referencing parameters that were stored encrypted, use 
the Intent option to pass the parameter value Encrypted, 
Decrypted or using dBase64 encoding. For more information, 
refer to the Parameter Reference description in Table 3 on 
page 47. 

4 Click Done. 

5 Add as many parameters as you need. 

6 Click Done when you have added all the parameters. 

The parameters are created. Repeat this procedure whenever you need to 
create parameters in this section. When you have finished, you can add 
instances of the section. Validation is performed on saving, opening, and 
deleting a parameter. An hourglass is shown during validation. 

To add an instance of a section 

1 From the Configuration tab, click [ + ] underneath the sections box. 

2 Click New Instance. 

3 Select a section to add an instance, and type an Instance name.  

4 Click Done. 

5 Click the new instance name under its Section in the Section list box. 

6 Type in the required parameters. 

7 Click Next to complete the creation of the new instance. 

The new instance is created. You are now able to refer to this instance in 
your Commands. 

 
If there is only one instance of a section, that instance will 
automatically display when you click on the section name. If there 
are multiple instances, the instance names will be nested under 
the Section name. 
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File Templates 

The AMP Editor allows you to add and delete lines in File Templates, as well 
as add If statements. File templates may be used to modify installation files. 

To first add a file to the File Templates section, click the File Templates tab, 
click [ + ] below the section box, and select the file. 

Figure 7 View the File Templates tab 

 

• Click Add line to add a line to the file template. 

• Click Remove line to remove a line from the file template. 

• Click Move Up to move a line up in the file template. 

• Click Move Down to move a line down in the file template. 

• Click Add If block to add an If statement. You will need to include a 
condition, a value if the condition is true, and a value if the condition is 
false. If the false value is not needed, simply highlight the line with the 
<ELSE> and click Remove line. The whole else clause will be removed. 

• To edit a line, double-click that line. 

34 Chapter 3 



 

Search Filters 

Use the Search Filters tab to create expressions to search for in the files on 
the target device. These filters can then be used to search files or data for 
specific information using the Scan command. Related commands are Delete 
Data, Insert/Replace data, Read File Data and Save Data.  

The results of the scans will most likely be used with Search Result string, 
Search Result number, Search Result Location, and the 
Insert/Replace data commands.  

 
The HP Live Network can be used to access AMP samples, including 
examples of how to use the search filters. 

Creating Search Filters 

Use the Search Filter tab to define search expressions.  

To create a search filter 

1 Click the Search Filter tab. 

2 Click [+]. A New Search Element appears. 
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3 Type in a Title and Description for the Search Element. 

4 Click the ellipsis at the end of the Regular Expression drop-down list to 
create an expression to search for. 

5 Click Edit to begin creating your expression. 

6 In the example below, we create a search string of 119. 
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7 Click Update, and then Save. 

8 If the search expression is case-sensitive, check the Case Sensitive box. 

9 From the Instance Number drop-down list, select if you would like to find 
All Matches, just the first match, or just the last match. You can also 
enter a number to find that particular match. For example, type 5 to find 
the fifth match. 

10 If you want to use this Search Filter in the Insert/Replace Data and 
Delete Data commands, you must check the Save Results box. 

11 From the Use drop-down list, select to use either the Matched Data or 
the Captured Groups. 

— Use Matched data to replace all occurrences of a string value with 
another string value. You are not interested in the parts of what you 
find, but rather the whole value. For example, you want to replace 
\\WIN2KSERVER89 with \\WIN2KSERVER34. The parts of the value, 
WIN2K, SERVER and 89, are not relevant. 

— Now, suppose that you still want to find \\WIN2KSERVER89 but want 
to change it to \\WIN2K89SERVER. In this case, you would write an 
expression that searches for these strings and divides them up into 
groups, \\WIN2K, SERVER, and 89. Then, you can switch and replace 
easily because Captured groups lets you reference these parts of a 
search expression individually. 
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12 From the Data Type drop-down list, select the scanned data’s type. 
Below is a complete example. 

 

Adding Commands 

Create commands to further control your installation. Add a command by 
clicking [+] in an application management phase such as Initialize, Pre-
Install, Install, Verify, Update, Repair, or Delete. 

Note that on 64-bit Windows architectures the agent and profiles will run in 
32-bit emulation mode. HP recommends using fully qualified paths in your 
profiles to make sure that you are able to run 64-bit executables on 64-bit 
operating systems. The agent and profiles may be affected by registry and file 
redirection as documented in the Microsoft knowledge base articles, Overview 
of the compatibility considerations for 32-bit programs on 64-bit versions of 
Windows Server 2003 and Windows XP. As always, be sure to test your 
profiles thoroughly before deployment. 

For each command, specify a Command title and a Command description. 
Each command has its own set of parameters that you will need to specify. 
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You can use cut, copy, and paste commands. To do this, right-click the mouse 
on the command you want to perform the action on.  

 
To quickly select an existing command, type its first-character to 
jump to and cycle through the commands beginning with that 
character. 

Commands can be copied to the same phase or another phase. Note that if 
you copy and paste a command into the same phase, the name will be copied 
as well. You may want to change the name of the pasted command to avoid 
confusion. Be aware of any references to other commands in the original 
phase. 

 
Starting with version 5.00, the installation media contains a 
Media\Application Management Profiles\Profile Samples 
directory. This directory contains examples of many of these 
commands.  

You can choose from the following commands. The command list will be 
filtered to show only those commands appropriate to the Platform selected 
(either Windows, UNIX or Any) in the Header Tab, Header Info area of your 
profile.  

Table 2 Command descriptions 

Command Type Description 

Change State of Windows 
Service 

Use this to change the state of a Windows 
Service. For example, you may need to stop a 
Windows Service to install the application, or 
need to restart a service after installation. 

Change UNIX 
owner/group/permission 

Use this command to change ownership, 
group membership, or permissions of an 
existing UNIX file or directory. 

Change Windows 
File/Directory attributes 

Use this command to modify 
readonly/archive/system/hidden 
attributes of an existing Windows file or 
directory. 

Check Registry Use this to check for the existence of a given 
registry entry. Returns a value >0 if found. 
Returns 0 if no entry is found. 

Copy file Specify an existing file to copy. 
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Command Type Description 

Create a windows service Use this to create a Windows service. Specify 
the name of the service, path to its 
executable, and any dependencies. You can 
also decide if you want the service to have 
the ability to interact with the Desktop. 

Create directory Specify a directory to create. If the 
intermediate directories do not exist, they 
will be created. If the directory already 
exists, then the directory will not be 
recreated. 

Create File Select a file to create during the phase. 

Delete data Use this command to delete data you find 
using the Search Filter tab. 

Exit Use this to end the current execution of the 
Application Manager agent on the target 
device. 

External Select this to run an external command. You 
will be required to include all necessary 
information to run the external command. 

Fetch a URL Use this to connect to a URL. Support for 
http proxies and authentication is included. 

File Operations Use this to normalize file names, use the 
appropriate characters for your operating 
system (native), or to delete a file. 

Generate random numbers Use this to generate random numbers with a 
given range of values. You can specify if you 
want the numbers to be unique. 

Get an attribute value from 
a client object 

Use this to get the value of an attribute from 
a Client Automation object. You will need to 
specify the directory location of the object 
such as Current Application Directory, 
Object Directory, COP Directory or Object 
Model. 

Get Disk Space Get the amount of disk space on the target 
computer. You have the option of finding 
either total capacity or free disk space. 
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Command Type Description 

Get Registry Value Use this to get the registry value for a 
specify key if there is a value. If not, returns 
an empty string. To check for the existence of 
a registry key, leave the value blank. 

Insert/Replace data Use this with Search Filter to insert or 
replace data in a file. 

Load balancer interaction Use this to add or remove the application 
from a pool of load balancers. AMPs supports 
F5 BIG-IP, Cisco CSS 11500 Series Content 
Services Switches, and Nortel Application 
Switch Operating System 22.0. 

Network Share Use this to connect or disconnect from a 
network share. If the installation media is 
located on your network, you will need to 
specify a network location and credentials 
before starting the installation. 

Read File Data Use this command to read data from a file on 
the target device and assign the data to the 
command output. The output can then be 
used by other commands. 

Reboot device Use this to Restart, Power Off, Logoff or 
Shutdown the target computer. 

Remove directory Use this command to specify a directory to be 
removed. If the directory does not exist, then 
no action will be taken. 

Rename file Use this command to rename a file. 

Save data Use this command to saves the scanned and 
updated data to disk. 

Scan Scans the data using defined Search Filters. 
The data can be from a file, command output 
or a parameter reference. 

Set an attribute in a client 
object 

Use this to set the value of an attribute of a 
HPCA Object. You will need to specify the 
directory location of the object such as 
Current Application Directory, Object 



 

Command Type Description 

Directory, COP Directory or Object Model. 

Set Environment variable Use this to set an environment variable. See 
Environment Variables, on page 117 for a 
list of possible environment variables. 

Set Parameter Use this to set a parameter’s value for an 
instance from the Configuration tab. 

Set Registry Value Set a value in the Registry using this 
command. 

Set/Get Values from INI 
files 

Use this command to set or get values from 
an ini file. You will need to specify the path 
to the ini file. 

Sleep for seconds and 
milliseconds specified 

Specify a period of time for the process to 
sleep. Use this to create a pause between 
commands processing to allow for command 
clean up. 

Validate files used in a 
manifest 

Use this command to validate files based on 
a list in a file manifest. 

Verify UNIX File/Directory 
Attributes 

Check attributes of an existing UNIX file or 
directory. You can verify the owner, group, 
permissions, accessed time, size, MD5 
signature, or version. Any attribute that is 
left blank will not be checked. 

Verify Windows 
File/Directory Attributes 

Check attributes of an existing Windows file 
or directory. You can verify read only, 
system, hidden, archive, accessed time, size, 
MD5 signature, or version. Any attribute 
that is left blank will not be checked. 

Windows Service Query Use this to find if a Windows Service exists 
or to find if the Service is stopped, started, or 
disabled. 

WMI This command provides WMI query, 
notification, and execute on a local or remote 
device. 

Xquery Run an Xquery to get or set attribute or node 
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Command Type Description 

values in an XML document. 

Pre-Conditions and Post-Conditions 

For each command, you can specify a pre-condition and a post-condition. Use 
these to control the flow of commands. Pre-condition checks allow or prevent 
an action to be run if certain criteria are met. Post-conditions are used to 
abort the entire profile if the status after a command runs does not meet 
certain criteria. Be sure to provide a descriptive error message to show why 
the flow of commands may be modified. This error message is displayed in 
the client computer’s connect.log and in the Reporting Server. 

Using a Pre-Condition 

If the pre-condition is false or not met, the command will not run. The 
command will be skipped, and we will go to the next command in the chain. 
In other words, the command will run only if the pre-condition is true or met. 
In the example below, the pre-condition states that the computer should be 
rebooted only if the Install MSSQL Server command returns a 3010 code. If 
it does, then the computer is restarted.  If the return code is not 3010, then a 
"Reboot not required message" is displayed, and the profile goes to the next 
command, in this case, Restart SQL Server. 



 

Figure 8 Use a pre-condition 

 

Using a Post-Condition 

If the post-condition is false or not met, the profile will stop. Suppose that the 
installation requires 350 MB of free disk space. Create a post-condition on 
the Get Disk Space command that will check if the free disk space is more 
than 350 MB. In the example, below the free disk space on the target 
computer is compared to the Free Disk Space parameter in the Requirement 
Definitions section of the Configuration tab. If the target computer has more 
than 350 MB free disk space, then the profile continues. If the target 
computer has less than or equal to 350 MB free, the profile will stop, and the 
error message "We need at least 350 MB of free space on the installation 
drive to install" will display. 

 
If there is no post-condition, then the profile will go to the next 
command regardless of the result of the command. 
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Figure 9 Use a Post-condition 

 

Condition Processing Summary 

The profile will run this command and go to the next command if: 

• There is a pre-condition that is met, the command runs, and there is no 
post-condition. 

• There is a pre-condition that is met, the command runs, and there is a 
post-condition that is met. 

• There is no pre-condition, the command runs, and there is no post-
condition. 

• There is no pre-condition, the command runs, and there is a post-
condition that is met. 

The profile will skip this command, but go to the next command if: 
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• There is a pre-condition that is not met. The post-condition is irrelevant 
in this case. 

The profile will abort, and display the post-condition error message if: 

• There is a pre-condition that is met, and the command runs, but the post-
condition is not met. 

• There is no pre-condition, the command runs, but the post-condition is 
not met. 

The profile will abort, and will not display the post-condition error message if: 

• There is a pre-condition that is met, but the command fails to run. 

• There is no pre-condition, but the command fails to run. 

If the command fails to run, the post-condition is evaluated for 
existence only. The Application Manager agent aborts the 
profile. Any error messages that get returned are not part of the 
post-condition. In addition even if a profile stops due to a failing 
post-conditions, the AMP will still execute the commands in the 
Cleanup phase. 

Building a String 

Some of the parameters for a command may require building an argument 
string. To do this, use the String Builder. To start using the string builder, 
click on the ellipsis at the end of a parameter. Depending on the parameter, 
the following operands may be available in the String builder. 

 
If you hover over an item in the Edit box in the String Builder, help 
text will appear at the bottom of the dialog. 

Table 3 Available operands in the String Builder 

Operand Description 

Client Object 
Reference 

Use to reference a client object. This may also be 
referred to as an agent object. 

Command 
Output 
Reference 

Use to refer to the output of another command from any 
phase of the application profile. 
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Operand Description 

Command 
Return 
Reference 

Use to refer to the return code of another command 
from any phase of the application profile. 

Credential 
Reference 

Use this when you need a set of credentials, such as 
connecting to a network share. 

Environment 
Reference 

Use to create an Environment Reference. 

File Content 
Reference 

Use to refer to an entry in the File templates section. 

If block Use this when you will need to branch the expression. 
You will need to provide a condition, a value if the 
condition is true, and a value if the condition is false. 
Note you can create nested If statements. 

List the search 
elements to use 

Use this to select a defined Search Filter. 

Null Use this if you want an empty value. 

Number Use this to type in a numeric value. 
The input field will accept the decimal point character 
that is defined in the message catalog. The default is a 
period.  

Number cell For WMI, a single cell from a table section array if the 
parameter in the section is a string. 

Number of rows For WMI, the number of rows in a table section array. 

Parameter 
Reference 

Use to reference a parameter from the Configuration 
tab. 
If the parameter value was stored encrypted, use the 
Intent drop-down box to specify how to pass the 
parameter value: 

• Base64 – Reference the Base64 encoded value of 
the decrypted value. 

• Decrypt – Reference the decrypted value. 
• Encrypted – Reference the encrypted value. 

Search Result 
string 

Use this if the result of a Scan command using a Search 
Filter returns a string. 



 

Operand Description 

Search Result 
number 

Use this if the result of a Scan command using a Search 
Filter returns a number. 

Search Result 
boolean 

Use this if the result of a Scan command using a Search 
Filter returns a boolean. 

Search Result 
location 

Use this as an index if there is more than one search 
result.  For example, if a search returns 5 matches, you 
can specify the third match (3). 

Space Use to add a space to the string. 

String Use this to type in a string of text. 
Note:  If you are creating a string, that has a tab 
character in it, the tab will display as <Tab> in the 
String Builder. 

String cell For WMI, a single cell from a table section array if the 
parameter in the section is a string. 

Command Modes 

Some commands only need to be executed when the client is running in a 
specific mode. The possible modes are create, delete, verify, update, and 
repair. These modes together form life cycle management of an application 

This mode is available for the Application Manager agent to use. The mode 
can be used to control when commands and phases are performed. By default, 
the mode is blank; this means that the command or phase would be executed 
in all the life cycle management modes of the Application Manager agent. If a 
phase or command has a specific mode defined, the mode would be compared 
with the current life cycle management mode. If the life cycle management 
mode matches the command or phase mode, then the command or phase 
would be executed. Otherwise, the command or phase would be skipped. For 
example, if the command or phase should be executed only when the client is 
doing a create or a verify, then you would select the create and verify modes 
in the Modes for this command section. If the life cycle management mode 
does not match the phase or command mode, then the phase or command 
would be skipped. 

 
If the modes for a phase are only create and delete, then the command 
modes for commands in a phase will also only be create and delete. 
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Command Examples 

The sections below detail some of the commands and how to use the String 
Builder by example. You can find these examples in the Media\Application 
Management Profiles\Profile Samples directory provided by HP on the 
Client Automation media. For parameters and complex parameters within 
commands, the AMP Editor supports a minimum length of zero, and will 
write NULL when no value is entered. 

 
Examples of almost all of the commands are now included in the 
samples directory on the installation media. Some of these are shown 
in this section. 

Change State of Windows Service 

In the procedure below, you will start the Apache Service after installation. 
The Service to start will be specified by creating a parameter reference. You 
can find this in the Install phase. 

To change the state of a Windows Service 

1 In the Add Command dialog box, click Change State of Windows 
Service. 

2 Type a short, descriptive Command Title, and an explanatory Command 
Description. 

3 Click Done. 

Packaging Applications 49 



 

 

4 Click on the ellipsis at the end of the Service name field to start the 
String Builder. This is the service you will be changing the state of. 

5 Click Edit. 

6 From the Operands, click Parameter Reference. 

7 From the drop-down list, click the section you want to get the parameter 
from. In this case, we select the Service Name from Product 
Configuration Options. 
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8 Click Update, and then click Save. 

9 From the Action drop-down list, click Start. 
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The results of your new command are displayed. 

Change UNIX owner/group/permission 

In the example below, we will change the owner of the media directory during 
the Pre-Install phase of the Oracle profile. 

To change the owner, group, or permission of a UNIX file 

1 In the Add Command dialog box, click Change UNIX 
owner/group/permission. 

2 Type a short, descriptive Command Title, and an explanatory Command 
Description. 

3 Click Done. The main screen of the Change UNIX owner/group 
/permission command displays. 
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4 Click on the ellipsis at the end of the File/Directory Name field to start 
the String Builder. This is the name of the file or directory that you want 
to change. 

5 Click Edit. 

6 From the Operands, click Parameter Reference. Enter the appropriate 
reference. 

 

7 Click Update, and then Save. 

8 Check the box if you want to recurse subdirectories. 
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The results of your new command are displayed. 

Create directory 

In the example below, we will create the BEA Home directory for WebLogic 
during the Pre-Install phase. 

To create a directory 

1 In the Add Command dialog box, click Create directory. 

2 Type a short, descriptive Command Title, and an explanatory Command 
Description. 

3 Click Done. The main page of the Create Directory command will display. 

4 Click on the ellipsis at the end of the Directory Name field to start the 
String Builder. This is the name of the directory to create. Note that you 
can also specify an owner, a group, and permissions. 

5 Click Edit. 

6 From the Operands, click Parameter Reference. Select the set of values 
you need. 
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7 Click Update, and then Save. 
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The results of your new command are displayed. 

Create File 

In the procedure below, you will create a configuration file, virtweb.txt, for 
Apache Virtual Web during the Install phase. The file information will be 
retrieved from the File Template. 

To create a file 

1 In the Add Command dialog box, click Create File. 

2 Type a short, descriptive Command Title, and an explanatory Command 
Description. 

3 Click Done. The screen for the Create File command is displayed. 
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4 Click on the ellipsis at the end of the File Name field to start the String 
Builder. This is the file you will be creating. 

5 Click Edit. 

 

6 From the Operands, click File Content Reference. Select the file to 
create. Type a directory and a file name. Check if you want to delete the 
file after use. 

7 Click Update, and then Save. 
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The results of your new command will be displayed. 

Delete Data 

In the example below, we find and delete all occurrences of "119" in a file. 

To use Delete Data 

1 In the Add Command dialog box, click Delete Data. 

2 Type a short, descriptive Title, and an explanatory Command 
Description. 

3 Click Done. 
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4 Since we want to find all occurrences of "119", we will select the Specify 
loop reference check box. 

Before using the Delete data command, you must have a Scan 
command which searches for the data you are going to delete. 

5 Click the ellipsis next to Loop Reference to build an argument string. 

6 Click Add to begin creating the Search Result Loop reference to your 
Scan command. 

Packaging Applications 59 



 

 

7 Click Update and Save when you are finished. 

8 Click the ellipsis after Search Location to set your search location. 

9 Set the Command Output Type. 
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The results of your new command are displayed. 

External 

In the example below, we need to run an external command. This command 
runs the installation for Microsoft Internet Information Server during the 
Install phase. 

To use an external command 

1 In the Add Command dialog box, click External. 

2 Type a short, descriptive Command Title, and an explanatory Command 
Description. 

3 Click Done. 
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4 Click on the ellipsis at the end of the Command field to start the String 
Builder. This is the external command you want to run. 

5 Click Edit. 

6 From the Operands, click Parameter Reference. 

7 Click Update, and then Save. 

8 Click on the ellipsis at the end of the Arguments field to start the String 
Builder. Set all arguments for the external command here. 

9 Click Update, and then Save. 

10 Check if you want to wait for the command to end. 
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11 If needed, select a Working Directory, Output File, and Run as user 
credentials. 

Running an external command as a different user is supported 
on Windows platforms, only. 

12 Click Update, and then Save in the String Builder after you have edited 
all needed fields. 

 

The results of your new command will be displayed. 

File Operations 

In this example, we want the remove the configuration file for Apache as part 
of the Delete phase. 
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To perform a file operation 

1 In the Add Command dialog box, click File Operations. 

2 Type a short, descriptive Command Title, and an explanatory Command 
Description. 

3 Click Done. The main page of the File Operations command is displayed. 

4 From the Operation drop-down list, select the operation you wish to 
perform. 

5 Click on the ellipsis at the end of the File name field to start the String 
Builder. This is the file name you will be performing the operation on. 

6 Click Edit. 

7 From the Operands, click Parameter Reference. 

8 From the drop-down list, click the section you want to get the parameter 
from. 
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9 Click Update, and then click Save. 

 

The results of your new command will be displayed. 

Get Disk Space 

In the procedure below, you will check a drive to see if it has adequate space 
for the installation of Microsoft Internet Information Server. The drive will 
be specified by creating a parameter reference to a directory path. Then, the 
drive where the directory resides will be checked. 

To get disk space information 

1 In the Add Command dialog box, click Get Disk Space. 

2 Type a short, descriptive Command Title, and an explanatory Command 
Description. 

3 Click Done. 
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4 Click on the ellipsis at the end of the Drive Letter field to start the String 
Builder. This is the drive or path on the drive you will be checking. 

5 Click Edit. 

6 Click Parameter Reference. 

66 Chapter 3 



 

 

7 Click Update, then click Save. 

8 From the Type drop-down list, click Free. 
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The results of your new command will be displayed. 

Get Registry Value 

In the procedure below, you will fetch a registry value to get the installation 
path for Microsoft Windows. This is required for the installation of Microsoft 
Internet Information Server. 

To get a registry value 

1 In the Add Command dialog box, click Get Registry Value. 

2 Type a short, descriptive Command Title, and an explanatory Command 
Description. 

3 Click Done. 
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4 Click on the ellipsis at the end of the Key field to start the String Builder. 
This is the key you will be getting the information from. 

5 Click Edit. 

6 From the Operands, click String. 

7 Type the full path to the registry key you are fetching the value from. 

8 Click Update, and then Save. 

9 Click on the ellipsis at the end of the Value field to start the String 
Builder. This is the registry value you will be getting. 
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10 Click Update, and then Save. 

11 The results of your new command will be displayed. 
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Insert/Replace Data 

In the example below, we will replace all occurrences of "119" with "120" in a 
hosts file. 

To use Insert/Replace data 

1 In the Add Command dialog box, click Insert/Replace Data. 

2 Type a short, descriptive Title, and an explanatory Command 
Description. 

3 Click Done. 
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4 Since we want to find all occurrences of "119", we will select the Specify 
loop reference check box. 

Before using the Insert/Replace data command, you must have a 
Scan command which searches for the data you are going to 
replace. 

5 Click the ellipsis next to Loop Reference to build an argument string. 

6 Click Add to begin creating the Search Result Loop reference to your 
Scan command. 
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7 Click Update and Save when you are finished. 

8 Click the ellipsis after Search Location to set your search location. 

9 In the Option drop-down list, select if you want to overwrite the data, 
insert in the beginning, or insert in the end. 

10 Type the Data you want to replace with. 

11 Set the Command Output Type. In this case, we use string. 
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The results of your new command are displayed. 

Network Share 

In the procedure below, we need to connect to a network share to install 
Microsoft SQL Server. Credentials must be supplied during the Install phase. 

To specify information for a network share 

1 In the Add Command dialog box, click Network Share. 

2 Type a short, descriptive Command Title, and an explanatory Command 
Description. 

3 Click Done. The main page of the Network Share command is displayed. 

4 Click on the ellipsis at the end of the Share Name field to start the String 
Builder. This is the parameter you will be setting the value for. 
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5 Click Edit. 

6 From the Operands, click Parameter Reference. 

7 From the drop-down list, click the section you want to get the share name 
from. 

8 Click Update, and then Save. 

9 From the Action drop-down list, click Connect or Disconnect. In this 
case, we want to connect. 

10 Click on the ellipsis at the end of the Credentials field to start the String 
Builder. These are the set of credentials you will use to connect to the 
network share. 

11 Click Edit 

 

12 Click Update, and then Save. 
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The results of your new command will be displayed. 

Reboot device 

In this example, we will restart the target computer. Note that this contains 
a pre-condition to see if a reboot is needed. This example is from the Install 
phase of the Microsoft SQL Server profile. 

To reboot a device 

1 In the Add Command dialog box, click Reboot device. 

2 Type a short, descriptive Command Title, and an explanatory Command 
Description. 

3 Click Done. The main page of the Reboot device command is displayed. 

4 From the Type drop-down list, click the type of reboot you want. Your 
options are Restart, Power Off, Logoff, and Shutdown. 

76 Chapter 3 



 

 

The results of your new command are displayed. 

Remove Directory 

In the example below, we remove the domain directories during the Uninstall 
phase of BEA WebLogic. 

To remove a directory 

1 In the Add Command dialog box, click Remove directory. 

2 Type a short, descriptive Command Title, and an explanatory Command 
Description. 

3 Click Done. The main screen of the Remove directory command is 
displayed. 

4 Click on the ellipsis at the end of the Directory Name field to start the 
String Builder. This is the name of the directory to remove. 
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5 Click Edit. 

6 From the Operands, click Parameter Reference. Select the set of values 
you need. 

7 Click Update, and then Save. 

 

8 Check the box to delete subdirectories. 
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The results of your new command are displayed. 

Scan 

In the example below, we scan for "119" in a file. Usually, this command is 
used before Delete Data, Insert/Replace or Save data. Note that you need to 
define a Search Filter before using this command. 

To use Scan 

1 In the Add Command dialog box, click Scan. 

2 Type a short, descriptive Title, and an explanatory Command 
Description. 

3 Click Done. 
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4 Click the ellipsis next to Search ID to build an argument string. 

5 Click Edit. 

6 Select the List search elements to use operand. 

7 From the Search Filter drop-down list, select your search filter. In this 
example, we had already defined "Search for 119" in the Search Filters 
tab. 
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8 Click Update and Save when you are finished. 

9 From the Scan mode drop-down list, select if you want to search by line or 
treat the data as a single block. 

10 If you need the data found to be saved after the program ends then 
enable the save option. Usually, the scanned result data is only available 
during the execution of the program so that other commands can use it. 
The results are deleted when the program ends.  

11 Click the ellipsis after File name to set the file to be scanned. The data to 
scan can be from a file, parameter reference, or command output. 
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The results of your new command are displayed. 

Set Parameter 

In the procedure below, you will set the Media Directory for installation using 
the Set Parameter Command. This example is from the Install phase of the 
Oracle profile. 

To set a parameter from a Client Object 

1 In the Add Command dialog box, click Set Parameter. 

2 Type a short, descriptive Command Title, and an explanatory Command 
Description. 
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3 Click Done. The main screen for the Set Parameter command will 
display. 

4 Click on the ellipsis at the end of the Parameter name field to start the 
String Builder. This is the parameter you will be setting the value for. 

5 Click Edit. 

6 From the Operands, click Parameter Reference. 

7 From the drop-down list, click the section you want to get the parameter 
from. In this case we select Installation Configuration, the default 
instance, and Install Media Directory. 

8 Click Update, and then Save. 

9 Click on the ellipsis at the end of the Value field to start the String 
Builder. This is the value you will be setting the parameter to. 

10 Click Edit. 

11 Enter the required information. ZDSPM000 is a single instance copy of 
an object that is currently running a method such as CREATE. This 
allows the current method to reference information about the instance 
that spawned it. The current method does need to know the details of the 
original object, such as the object name or instance number that contains 
the specific instance data. In this example, ZDSPM000 tells us the 
MEDIADIR. 

12 Click Update, and then Save. 

The results of your new command will be displayed. 

Set Registry Value 

In the example below, the media directory for Windows must be reset in the 
registry. This is required in the Install phase for Microsoft Internet 
Information Server. 

To set a registry value 

1 In the Add Command dialog box, click Set Registry Value. 

2 Type a short, descriptive Command Title, and an explanatory Command 
Description. 

3 Click Done. The main screen for the Set Registry Value command will 
display. 



 

4 Click on the ellipsis at the end of the Key field to start the String Builder. 
This is the key you will be getting the information from. 

5 Click Edit. 

6 From the Operands, click String. 

7 Type the full path to the registry key you are going to set. 

8 Click Update, and then Save. 

9 Click on the ellipsis at the end of the Value field to start the String 
Builder. This is the registry value you will be setting. 

10 Click Edit. 

11 From the Operands, click String. 

12 Type the value you are going to set. 

13 Click Update, and then Save. 

14 Click on the ellipsis at the end of the Data field to start the String 
Builder. This is the data you will set the value to. 

15 Click Edit. 

16 From the Operands, click Parameter Reference. In this case, we are 
setting the Source Directory to the Media Directory. 

17 Click Update, and then Save. 

18 From the Type drop-down list, select the data type. 

The results of your new command will be displayed. 

Verify UNIX File/Directory Attributes 

In the example below, we will use this command to check the existence of the 
WLST files. These are a requirement for the installation of WebLogic Server. 

To verify the attributes or existence of a UNIX files or directory 

1 In the Add Command dialog box, click Verify UNIX File/Directory 
Attributes. 

2 Type a short, descriptive Command Title, and an explanatory Command 
Description. 

3 Click Done. The main screen of the Verify UNIX File/Directory Attributes 
is displayed. 
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4 Click on the ellipsis at the end of the File/Directory Name field to start 
the String Builder. This is the name of the file or directory to check. 

5 Click Edit. 

6 From the Operands, click Parameter Reference. 

 

7 Click Update, and then Save. 

8 In the Type drop-down list select if this is a file or a directory. In this 
case, we are checking file. 

9 Edit the attributes as needed. 

 
If no attributes are specified, only the existence of the file or 
directory will be checked. 
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The results of your new command are displayed. 

Verify Windows File/Directory Attributes 

In the example below, we will check the existence of the WLST file for 
Weblogic for Windows. This is part of the Install phase. 

To verify the existence or attributes of a Windows file 

1 In the Add Command dialog box, click Verify Windows File/Directory 
Attributes. 

2 Type a short, descriptive Command Title, and an explanatory Command 
Description. 

3 Click Done. The main screen for Verify Windows File/Directory is 
displayed. 

4 Click on the ellipsis at the end of the File/Directory Name field to start 
the String Builder. This is the name of the directory to remove. 

5 Click Edit. 

6 From the Operands, click Parameter Reference. 
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7 Click Update, and then Save. 

8 In the Type drop-down list select if this is a file or a directory. In this 
case, we are checking a directory. 

9 Edit the attributes as needed. 

 
If no attributes are specified, only the existence of the file or 
directory will be checked. 

 

The results of your new command are displayed. 

WMI Commands 

The WMI command has three options, WMI Query, WMI Notification, and 
Execute method. The command examples are supplied below. 

Execute method 
Use the Execute method option to execute a method defined in a WMI object. 
IN the example below, we will run a method on the target device. 

To use the WMI Execute Method Option 

1 In the Add Command dialog box, click WMI. 

2 Type a short, descriptive Command Title, and an explanatory Command 
Description. 

3 Click Done. 

4 From the Option drop-down list, click Execute Method. 
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5 Click on the ellipsis at the end of each of your required parameters. They 
are described below. 

— Object: Enter a WMI object for which you would like to execute the 
method, for example, Win32_Process. 

— Method: Name of the method to execute from the WMI object. 

— Input Parameters: Enter a list of strings with the first element 
describing the parameter name, and the second its value. These 
parameters will be passed to the method being executed 

— Namespace: Enter a namespace, usually root\CIMV2. 

— Server: Enter a fully qualified server name. The default value of "." 
means the local computer 

— Credentials: If the WMI query requires a user and password when 
running remotely, then you can provide the credentials for the 
resource. The Credentials are created in the Credentials section in 
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the Configuration tab. Select a credential instance from the list. If the 
list is empty, create the Credentials element first. 

— Table: A WMI query/notification/execMethod can return multiple 
rows of data. To access the individual properties of WMI result 
Objects, you need to configure a section that allows you to define the 
column headings and the column type. This can be done by defining a 
new section in ConfigSpace and marking it as a table. Select an entry 
from the list that matches your table definitions. If you want to 
ignore the result set, select No Table. 

6 Check Save results if you would like to save the data for future 
reference when the program is run again at a later time. The WMI 
results are available during the execution of the Application Manager 
agent; when the program ends, the results are discarded by default. 

 

The results of your command are displayed. 

WMI Notification method 
Use the Notification method option to be notified when certain events occur. 
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To use the WMI Notification Method Option 

1 In the Add Command dialog box, click WMI. 

2 Type a short, descriptive Command Title, and an explanatory Command 
Description. 

3 Click Done.  

4 From the Option drop-down list, click WMI notification. 

 

5 Click on the ellipsis at the end of each of your required parameters. They 
are described below. 

— Query: Enter a query in the Windows Query Language format. 

— Namespace: Enter a namespace, usually root\CIMV2. 

— Server: Enter a fully qualified server name. The default value of  "." 
means the local computer 

— Credentials: If the WMI query requires a user and password when 
running remotely, then you can provide the credentials for the 
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resource. The Credentials are created in the Credentials section in 
the Configuration tab. Select a credential instance from the list. If the 
list is empty, create the Credentials element first. 

— Table: A WMI query/notification/execMethod can return multiple 
rows of data. To access the individual properties of WMI result 
Objects, you need to configure a section that allows you to define the 
column headings and the column type. This can be done by defining a 
new section in ConfigSpace and marking it as a table. Select an entry 
from the list that matches your table definitions. If you want to 
ignore the result set, select No Table. 

6 Check Save results if you would like to save the data for future 
reference when the program is run again at a later time. The WMI 
results are available during the execution of the Application Manager 
agent; when the program ends, the results are discarded by default. 



 

 

The results of your command are displayed. 

WMI Query method 
Use the WMI Query Method option to run a WMI Query. 

To use the WMI Query method 

1 In the Add Command dialog box, click WMI. 

2 Type a short, descriptive Command Title, and an explanatory Command 
Description. 

3 Click Done. 

4 From the Option drop-down list, click WMI Query. 
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5 Click on the ellipsis at the end of each of your required parameters. They 
are described below. 

— Query: Enter a query in the Windows Query Language format. 

— Namespace: Enter a namespace, usually root\CIMV2. 

— Server: Enter a fully qualified server name. The default value of "." 
means the local computer 

— Credentials: If the WMI query requires a user and password when 
running remotely, then you can provide the credentials for the 
resource. The Credentials are created in the Credentials section in 
the Configuration tab. Select a credential instance from the list. If the 
list is empty, create the Credentials element first. 

— Table: A WMI query/notification/execMethod can return multiple 
rows of data. To access the individual properties of WMI result 
Objects, you need to configure a section that allows you to define the 
column headings and the column type. This can be done by defining a 
new section in ConfigSpace and marking it as a table. Select an entry 
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from the list that matches your table definitions. If you want to 
ignore the result set, select No Table. 

6 Check Save results if you would like to save the data for future 
reference when the program is run again at a later time. The WMI 
results are available during the execution of the Application Manager 
agent; when the program ends, the results are discarded by default. 

 

The results of your command are displayed. 

Xquery 

Run an Xquery to get or set attribute or node values in an XML document. 
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To perform an Xquery 

1 In the Add Command dialog box, click Xquery. 

2 Type a short, descriptive Title, and an explanatory Description. 

3 Click Done. 

 

4 Click on the ellipsis at the end of the File Name field to start the String 
Builder. This is the file will be getting the information from. 

5 Click Edit. 

6 From the Operands, click String. 

7 Type the full path to the registry key you are fetching the value from. 

8 Click Update, and then Save. 

9 Edit any other parameters you require. 

10 Click Update, and then Save. 

The results of your new command will be displayed. 
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4 Preparing Applications 
At the end of this chapter, you will: 

• Be familiar with Utility Classes. 

• Know how to create a Service Instance for an application. 

• Be able to connect all required packages to the Service Instance. 
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Prepare the Package 
After packaging the media and creating the CAP, you will need to prepare 
the application for deployment. Use the AMP Editor to perform the following 
tasks. 

1 Create a Utility instance for the application. 

2 Publish the CAP. 

3 Create a Service instance in the HP Client Automation Configuration 
Server DB (CSDB). 

4 Connect the media package and utility instances to the Service. 

Figure 10 Workflow 
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Overriding Values in the AMP (Utility Instances) 
Utility Classes are used to create device-specific overrides for the CAP. Use 
the Utility instance for a Server Application to override values in the Custom 
Application Profile. This allows you to use one profile with small variations 
for each target computer in your enterprise. Use the AMP Editor to create 
and modify Utility instances. 

Creating the Utility Class 

Use the AMP Editor Synchronize Utility Class with this profile 
command to synchronize the RCS Section of the AMP with the appropriate 
Utility Class on the Configuration Server. 

 
Be sure to check Store in configuration server section in the Manage 
Parameters dialog box. You must do this to add the parameter to the 
Utility Class. To view all parameters that have this checked, use the 
HP Client Automation Configuration Server (Configuration Server) 
menu’s, Manage All Utility Class Parameters command. 

• If there is an RCS section in the AMP and no corresponding Utility Class 
in the CSDB, then the Utility Class will be created on the Configuration 
Server based on the RCS section in the AMP. 

• If there is no RCS section in the AMP and a corresponding Utility Class 
in the CSDB, then the RCS section will be added to the AMP based on the 
Utility Class. 

• If there is an RCS section in the AMP and a corresponding Utility Class 
in the CSDB, then the new and updated fields from the RCS section will 
be merged into the Utility Class in the CSDB. Change management 
processes must be followed explicitly. We do not advise using the AMP 
Editor against production databases. Use the AMP Editor against test or 
development CSDBs. 

Before you can synchronize the Utility Class, you must establish your 
Configuration Server, and the Utility Class the profile will connect to. 

To connect to a Configuration Server 

1 From the HPCA Configuration Server menu, click Edit HPCA 
Configuration Server Connection Information. This includes the 
Configuration Server IP address, port, user ID, and password. 
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2 Type in all information to connect to your Configuration Server. 

3 Click Save. 

To connect to a Utility Class 

1 From the Configuration Server menu, click Update Class Connection 
Information. 

2 Type in a name for the Utility Class. It must be eight characters or less. 

3 Click Save. 

To synchronize the Utility Class 

1 Select the Synchronize Utility Class with this profile command from the 
Configuration Server menu. 

If the Utility Class does not exist on the CSDB, you will be asked to 
create it. If it does exist but there are differences, you will be prompted 
with the changes and asked to accept them. 

2 Click Yes to create the class. 

3 The class is created. Click OK. 

Creating a Utility Instance 

In the example, below we will create a Utility instance to override the Oracle 
Instance name. 

To create a Utility instance 

1 From the HPCA Configuration Server menu, click Manage utility 
instances. 
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2 Click Save to confirm the Configuration Server Settings. 

3 Click Add to add an instance. If an instance already exists, you can delete 
or modify it. 

 
When you modify an instance, the values that are inherited 
from the base instances will be displayed in red and "**" will 
precede the name of the variable. 

In this example, we create an instance called ORASVR_FINANCE for a 
computer called FINANCE and change the ORASID to FINANCE. 
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4 Click Done. The instance appears at the top of the dialog box. 
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5 When you have finished adding, modifying, or deleting Utility instances, 
click Done. 

If a value exists in the Utility Class, the value is used instead of the value in 
the CAP. Use _NONE_ to tell the Application Manager agent that this 
variable has no value in the CSDB and the values from the CAP should be 
used. 

Naming and Connecting the Utility Instance 

There are multiple methods for connecting the Utility instance. The Utility 
instance for an AMP is specified when you create a new Service in the 
Override value during publishing of the AMP. (If you are using the HP Client 
Automation Administrator CSDB Editor (CSDB Editor) this corresponds to 
the ZSERVICE OVERRIDE attribute.) Decide on the method that best suits 
your needs. Then, you will need to use the appropriate naming convention for 
the Utility instance. The most common methods are described below. 
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If you do not have a valid Utility instance, the installation will fail. 
The agent methods for executing the installation of the applications 
are part of the Utility instance. 

• Multiple computers with identical configurations 

— Use a descriptive name for the Utility instance. For example, create a 
DEMOWEB instance in the VIRTWEB Class. 

— OVERRIDE Value: APPMGMT.VIRTWEB.DEMO_WEB 

• Each computer with one configuration 

— Create one instance for each target computer in the Utility Class. For 
example, create two instances in the APPMGMT.APACHE2 class. 
One named SRV020, and the other named SRV850. When the service 
is deployed, SRV020 will use APACHE2.SRV020. SRV850 will use 
APACHE2.SRV850. The computer name is taken from the ZUSERID 
attribute of the ZMASTER object. 

— OVERRIDE Value: APPMGMT.APACHE2.&(ZMASTER.ZUSERID) 

• One computer with multiple instances of the same application 

— Use this naming method when an application supports multiple 
instances, such as Microsoft SQLServer or Oracle. These applications 
allow for multiple instances of the application on one computer. 

— Name the Utility instance using the name of the computer followed 
by a descriptive suffix. For example, create three instances in the 
APPMGMT.MSSQL2K Class, SQLSRV_FINANCE, SQLSRV_HR, 
SQLSRV_DEV. In each of these instances, set the MSSQL2K. 
INSTNAME to a different value, such as FINANCE, HR, and DEV. 
Leave the other attributes at the _NONE_ value so the Application 
Management Profile’s values will be used. When the service is 
deployed to SQLSRV, Microsoft SQL Server will be deployed with 3 
named instances. 

— OVERRIDE Value: 
APPMGMT.MSSQL2K.&(ZMASTER.ZUSERID)_* 

Publishing a Profile 
After you have created your CAP, you are now ready to publish it to the 
Configuration Server Database (CSDB). During the publishing process, the 
AMP Editor will rename the CAP to control.xml, create an Application 
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(ZSERVICE) instance, connect the ZSERVICE to the designated media 
packages, and allow you to modify the connection to the Utility instance. 

To publish an Application Management Profile  

1 From the AMP Editor, select HPCA Configuration Server → Publish to 
Database. 

 

2 If this is the first time that you are publishing in the AMP Editor session, 
you will be asked to confirm the Configuration Server settings. 

3 Verify the Configuration Server setting, and click Save. 
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4 Type in the required data for the package information, and click Next. 
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5 Choose one of the following actions: 

— Click Create New to create a new Application (ZSERVICE) instance 
in the APPMGMT domain. 

— Click Use existing to connect to an existing Application (ZSERVICE) 
instance. If you use an existing service, the Override value will resort 
to the original default, and will add the xml package to the 
ZSERVICE connection. If you have had a non-default value when you 
originally created the service, be sure to change it if required. 
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Services should not be reused in production Do not use the HPCA 
AMP Editor on a CSDB that is in production. 

— Click No service to publish the AMPs only. You will need to connect 
it to an Application (ZSERVICE) instance using the CSDB Editor. 

In this example, we will create a new Application (ZSERVICE) instance. 

 
The Override connects to an instance of the Utility Class. For 
more information on creating the Utility Class and instances, 
see Overriding Values in the AMP (Utility Instances) on page 
99. 

Type in the appropriate values and click Next. 
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6 All instances in the Application Packages (PACKAGE) Class will be 
listed. Select the packages to connect to the Application (ZSERVICE) 
instance in addition to the AMPs, and click Next. 

7 Click Publish. Status will appear in the dialog box. 

 

8 Click Done after publishing is complete. 
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5 Managing and Reporting 
At the end of this chapter you will: 

• Know how to install the Application Manager agent. 

• Be able to view reports using the HP Client Automation Reporting Server 
(Reporting Server). 
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Application Manager Agent 
The files required to execute AMPs on a target device are part of the 
Application Manager agent.The Application Manager agent must be installed 
on any target computer that you want to deploy applications to. The 
Application Manager agent logs the nvdkit and agent versions as well as the 
header information from the profile in use in the connect.log, located in the 
log directory. 

 
As of Version 7.20, to use AMPs to deploy applications, the target 
devices must be installed with the Application Manager agent. 
There is no additional Agent or LTU required. 

Install the Application Manager agent from the installation media. For 
installation instructions and system requirements, refer to the HP Client 
Automation Application Manager and Application Self-service Manager 
Installation and Configuration Guide (Application Manager and Application 
Self-Service Manager Guide) for Windows or Unix. 

 
Note that on 64 bit Windows architectures the agent and profiles will 
run in 32 bit emulation mode. HP recommends using fully qualified 
paths in your profiles to make sure that you are able to run 64-bit 
executables on 64-bit operating systems. The agent and profiles may 
be affected by registry and file redirection as documented in the 
Microsoft knowledge base articles, Overview of the compatibility 
considerations for 32-bit programs on 64-bit versions of Windows 
Server 2003 and Windows XP. As always, be sure to thoroughly test 
your profiles before deployment. 

Reporting 
AMPs uses the Reporting Server for deployment status. Reporting Server 
version 5.00 is the minimum version required. To use the Reporting Server 
with AMPs, the HP Client Automation Messaging Server (Messaging Server) 
and the Reporting Server must be configured.  

Before performing these steps, be sure that you have set up a database to 
store the AMPs data and that, on the Messaging Server and Reporting 
Server, there is an ODBC connection to that database. 
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Implementation Details 

Refer to the HP Client Automation Reporting Server Installation and 
Configuration Guide (Reporting Server Guide) for information on installing 
the Reporting Server and the HP Client Automation Messaging Server 
Installation and Configuration Guide (Messaging Server Guide) for 
information on installing the Messaging Server. You must perform the 
additional steps listed in this section to enable the AMPs reports. 

Messaging Server Installation 

1 At the Select Data Delivery Agent window of the Messaging Server 
installation, select Load the core.dda module to post Core objects via 
ODBC. The core.dda module is required in order to have the data for 
AMPs reports collected and posted to the appropriate SQL database. 

 
This information is also included in the Messaging Server Guide. 

2 When prompted, enter the DSN information. 

3 Continue with the installation, following the instructions on the 
remaining dialog boxes. 

Reporting Server Installation 

1 After installing the Reporting Server, go to 
http://<reportingserveripaddress>/reportingserver/setup.tcl 

2 Click Inventory Manager Configuration. 

3 Type in your DSN information in the RIM DSN, RIM DSN User, and 
RIM DSN Password boxes. 

4 Click Server Management Configuration (SCM). As of this writing, the 
Server Management Configuration enables the reports for Application 
Management Profiles. 

5 For Enable SCM Reports, select 1. 

6 Click Apply and follow the on-screen directions. 

Viewing the Reports 

To view the reports, use an internet browser to go to your Reporting Server 
address. Then, click Server Management Reports to view the list of 
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Application Management Reports. Two reports are provided, Job Status by 
Device and Job Status by Service. 

Figure 11 Application Management Profile Reports 

 

• Job Status by Device 
Use this report to see the status of jobs by device name. The report 
includes information on status, reboots, and time of the last job’s start 
and end time. 

 

— Click Successful to view the successful jobs for the device. 

— Click Warning to see warnings associated with this device 

— Click Reboot Pending to see the jobs that require a reboot for 
completion. 

— Click Failed to see the list of failed jobs for this device. 

— Click Total Jobs to see the list of all jobs for this device. From within 
this report, you can drill down further to see detailed information for 
each job including installation parameters used. 

• Job Status by Service 
Use this report to see the status of jobs by Service name. The report 
includes service description, information on status, reboots, and time of 
the last job’s start and end time. 
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— Click Devices to see the list of devices that received this service. 

— Click Successful to view the successful jobs for the service. 

— Click Warning to see warnings associated with this service. 

— Click Reboot Pending to see the services that require a reboot for 
completion. 

— Click Failed to see the list of failed jobs for this service. 

— Click Total Jobs to see the list of all jobs for this service. From within 
this report, you can drill down further to see detailed information for 
each job. 
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A Environment Variables 
In addition to the standard platform-specific environment variables, such as 
windir=C:\WINDOWS for Windows operating systems, there are AMP specific 
environment variables which are listed below. The APPMGMT environment 
variables, like other environment variables, are usually used in environment 
references for pre- and post- conditions. You may also want to set a local 
variable to the value of an environment variable. 

List of Environment Variables 

• APPMGMT_BYTEORDER Byte Order 

• APPMGMT_MACHINE Processor 

• APPMGMT_OS Operating System 

• APPMGMT_OSCOMMONNAME Common Name of OS  

• APPMGMT_OSSSERVICEPACK Windows Service Pack 

• APPMGMT_OSVERSION Operating System Version  

• APPMGMT_PLATFORM Platform 

• APPMGMT_HOSTIP Host IP address 

• APPMGMT_HOSTNAME Fully qualified name of the machine 

• APPMGMT_PID Process Id of Application Manager agent 

• APPMGMT_STANDALONE  [Note: A Value of Y only applies to pre-
Version 7.20 releases; as of Version 7.20, support for AMPs is embedded 
in the Application Manager Agent.] If the AMP Agent is running under 
the Application Manager agent the value is N, otherwise it is running 
standalone and the value will be Y. 

• APPMGMT_PHASE_NAME Phase name that the Application Manager is 
currently executing. 

The following are examples of Windows XP values: 

• APPMGMT_BYTEORDER = littleEndian 

• APPMGMT_MACHINE = intel 

• APPMGMT_OS = Windows NT 
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• APPMGMT_OSCOMMONNAME = Windows XP 

• APPMGMT_OSSERVICEPACK = Service Pack 1 

• APPMGMT_OSVERSION = 5.1 

• APPMGMT_PLATFORM = windows 

• APPMGT_HOSTIP = 192.168.0.11 

• APPMGMT_HOSTNAME = LBLACK.americas.foods.com 

• APPMGMT_PID = 1800 

• APPMGMT_STANDALONE = Y  

• APPMGMT_PHASE_NAME = install 

The following are examples of Red Hat Linux values: 

• APPMGMT_BYTEORDER = littleEndian  

• APPMGMT_MACHINE = i686 

• APPMGMT_OS = Linux 

• APPMGMT_OSCOMMONNAME = Linux 2.2.14-5.0smp 

• APPMGMT_OSSSERVICEPACK = N/A 

• APPMGMT_OSVERSION = 2.2.14-5.0smp 

• APPMGMT_PLATFORM = unix 

• APPMGT_HOSTIP = 192.168.0.11 

• APPMGMT_HOSTNAME = LBLACK.americas.foods.com 

• APPMGMT_PID = 1900 

• APPMGMT_STANDALONE = Y 

• APPMGMT_PHASE_NAME = install 

The following are examples of HP-UX values: 

• APPMGMT_BYTEORDER = bigEndian 

• APPMGMT_MACHINE = 9000/800 

• APPMGMT_OS = HP-UX 

• APPMGMT_OSCOMMONNAME = HP-UX B.11.00 

• APPMGMT_OSSSERVICEPACK = N/A 
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• APPMGMT_OSVERSION = B.11.00 

• APPMGMT_PLATFORM = unix 

• APPMGT_HOSTIP = 192.168.0.11 

• APPMGMT_HOSTNAME = LBLACK.americas.foods.com 

• APPMGMT_PID = 1900 

• APPMGMT_STANDALONE = Y 

• APPMGMT_PHASE_NAME = install 

The following are examples of Solaris values 

• APPMGMT_BYTEORDER = bigEndian 

• APPMGMT_MACHINE = sun4u 

• APPMGMT_OS = SunOS 

• APPMGMT_OSCOMMONNAME = SunOS 5.9 

• APPMGMT_OSSSERVICEPACK = N/A 

• APPMGMT_OSVERSION = 5.9 

• APPMGMT_PLATFORM = unix 

• APPMGT_HOSTIP = 192.168.0.11 

• APPMGMT_HOSTNAME = LBLACK.americas.foods.com 

• APPMGMT_PID = 1900 

• APPMGMT_STANDALONE = Y 

• APPMGMT_PHASE_NAME = install 
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B Application Management Profiles 
Standalone Agent 

A command line utility, standalone agent, is available on the installation 
media to test a Master Application Profile (MAP) or Custom Application 
Profile (CAP). Use the standalone agent to execute profiles without the Client 
Automation infrastructure or to test the profile. The standalone execution 
runs as the logged on user. 

The standalone agent, includes the following arguments: 

• The –xml parameter is used to specify the profile you want to test. 

• The -mode parameter is used to specify the phase you want to run in the 
test. The possible values for mode are create (application installation), 
delete (application removal), verify (verification of application 
components), repair (repairing broken applications), and update (for 
updating an application). If mode is omitted, it will default to create 

• The -idmlib parameter specifies the location to build the Client 
Automation objects. If this parameter is not specified, the objects are 
built in the location of the appcntrl.tkd. If idmlib is omitted it will 
default to either IDMROOT, if the Client Automation agent or the 
Administrator is installed, or the current directory, if the agent or 
Administrator is not installed. Of course, this also depends on what 
directory option is chosen in the command itself. 

• The –logfile parameter allows you to set an alternate log file. The 
default is appcntrl.log. 

 
Be aware that this will not work for all AMPs. A profile that is 
designed to run locally may succeed. However, if the profile has 
dependencies between phases, then you will need to run all of those 
phases to get a reliable result. In other words, this is not guaranteed 
to work for all profiles. Always run the profile in a test environment 
before moving to production. 

To test a profile 

1 Load any media that the profile requires to the appropriate directory. 
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2 Copy the profile to the same directory as the Application Manager agent 
on the test device. 

3 Open a command prompt, and navigate to the directory where the 
Application Manager agent and the profile have been loaded. 

4 Type the following command: 

nvdkit appcntrl.tkd –xml filename.xml –mode modetotest 

The profile runs, and executes any commands that the profile indicates. All 
actions are logged to appcntrl.log in the same directory as appcntrl.tkd. 
Messages are appended to the end of the log with the most recent entries at 
the end. 

For testing the verify phase, you should following these steps: 

• Break the application. 

• Run this utility with –mode verify. 

• Confirm that the application was found to be broken by checking 
appcntrl.log. Also check that the log is reporting the correct error. 

As an option, run the utility with –mode repair. 
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example, 63 

file templates, 34 

File Templates tab, 23 

G 
Generate random numbers command, 40 

124 Index 



 

Get an attribute value from a client object command, 
40 

Get Disk Space 

command, 40 
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String operand, 48 

synchronize Utility Class, 100 

T 
Temporary Storage, 31 
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